
EXCEL / MEGASTAT Guide  Introduction 

Introduction 1 2/27/2007 

Math 227 –  EXCEL / MEGASTAT Guide 
 
Introduction:  EXCEL Basics 
 
Ch2: Frequency Distributions and Graphs 
Construct Frequency Distributions and various types of graphs: Histograms, Polygons, Pie 
Charts, Stem-and-Leaf Plots, Time-series graphs, Scatter plots. 
 
Ch3: Data Description 
Calculate Mean, Median, Mode, Range, Variation, Standard Deviation, Percentiles, Quartiles; 
construct Boxplots. 
 
Ch4: Probability and Counting Rules 
Probability distributions, Simulations, Factorials, Permutations, Combinations. 
 
Ch5: Discrete Probability Distributions 
Calculate and Graph Binomial Probabilities. 
 
Ch6: The Normal Distribution 
Use functions to calculate Cumulative and Inverse Cumulative Probabilities for Normal and 
Standard Normal Distributions, Central Limit Theorem . 
 
Ch7: Confidence Intervals and Sample size 
Calculate  z  and t   Confidence Intervals for the Mean and Proportion. 
 
Ch 8: Hypothesis Testing  
Hypothesis testing for Mean ( z  and t  distributions) and Proportion 
 
Ch 9: Testing the Difference between two Means, two Variances, and two Proportions 
Testing two variances, two means for independent samples, and two proportions 
 
Ch 10: Correlation and Regression 
Scatter plots, Correlation Coefficient, Regression Line, Significance of Correlation Coefficient. 
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EXCEL Basics 
 
• Cells 
• Reference 
• Selecting and Copying Cells 
• Inserting Columns or Rows 
• Formatting cells 
• Sorting data 
• Charts and Graphs 
• Functions 
 
Cells 
An EXCEL worksheet consists of a grit made of columns and rows. The columns are 
identified by letters: A, B, C, ….  and the rows by numbers: 1,2,3, ….  The intersections of the 
columns and rows are called cells.  A cell is addressed by its corresponding column and row: 
Example, the cell B4 refers to the cell at the intersection of column B and row 4. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 1 

Each cell can contain three types of data: numbers, text, and formulas.  In the example 
above, the cells C3 through C9 contain numbers, cells E3 through E7 contain text, and cells 
G3 though G8 contain formulas and functions. In order for EXCEL to interpret your input as 
a formula or function, you need to precede it by the “=” sign. The cells in column next to each 
function and formula in the example above represent the result of the calculations. 
 
You enter values in a cell by placing the cursor in the cell and then typing the value you want. 
When finished, use either the arrow keys to go to the next cell or the ENTER key to stay in 
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the same cell.  When you enter a formula or a function and press either the ENTER or 
ARROW key, Excel performs the requested operation and places the result in the cell where 
you typed the formula or function. 
 
 
Reference 
When we want to perform a calculation, we use formulas containing algebraic expressions 
and/or functions. We input the values that we want to use either as absolute numbers or as 
references to cells that contain the values we want to use.  Look at the next figure 2. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

    Figure 2 

Cells A1 through A10 contain a set of numbers. If we want to add the numbers in the first two 
cells, we can do it either as “=5+6”  or as “=A1+A2”. In either case, the result is 11. The 
second way instructs EXCEL to look into cells A1 and A2 and add the values it finds there. 
Then, if we change the contents of cells A1 or A2, the correct sum is calculated by EXCEL. 
(Experiment to get familiar with this concept). 
 
Cell A16 contains an example on how to use a built-in function, called SUM. A we explained 
before, you enter “=SUM(“, and then we need to tell EXCEL what to add. The expression 
A1:A10 defines a range of numbers, namely all numbers between the cells A1 and A10 
inclusive.  The calculated result is 58. If we change any of the values in the range A1:A10, 
EXCEL recalculates the sum automatically. 
 
The highlighted area above is an example of a two dimensional range:  E3:G6 
 
Practice: Perform a few algebraic calculations 
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Selecting and Copying Cells 
 
You select a single cell by placing the cursor into the desired cell and press the ENTER key. 
A thick line appears around the cell; see cell C1 in Figure 3. When a cell is selected like this, 
you can do one of two things: click the right mouse button, or copy the cell to adjacent cells. 
 
When you right-click the mouse, a drop down list of “things” you can do appears, like cut, 
paste,  …;   one of the most useful ones is the “Format Cells”.  Experiment with this list and 
see what you can do with the “Format Cells” option. 
 
In order to copy a cell to adjacent cells, do the following: When a cell is selected, a small 
square dot appears on the lower right corner of the cell. Move the cursor towards this dot. 
Once the cursor is located on top of the dot, it changes its shape into a cross.  When this 
occurs, press and hold the left mouse button.  Then, move the mouse either to the left if you 
want to propagate the contents of the cell to the left, or down if you want to propagate the 
contents of cell down 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
    Figure 3 
 
In our example, cell C1 contains the calculation to add the contents of cells A1 and B1.  We 
want to perform the same calculation for all the cells A2+B2, A3+B3, .. until A10+B10.  
Procedure:  
1. Enter the calculation to add A1, B1 in cell C1. 
2. Select cell C1. 
3. Move cursor to lower right corner of cell C1 until it turns into a cross. 
4. Press and hold the left mousse button, then drag the mouse down until you reach row 10.  
5. Release the mouse button. 
 
Observe what EXCEL has done with original cells!!  As it copied the formula from cell C1 to 
cell C2, it changed the cell references A1 and B1 to A2 and B2. Then, when it copied the 
formula from cell C2 to cell C3, it changed again the cell references A2, B2  to A3, B3, and so 
on. 
 
There are cases when we do not want EXCEL to “adjust” the cell references as we copy the 
original cell.  In order to accomplish this, we use absolute addressing, denoted with the 
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symbol “$”  placed in front of the column and/or row of the cell’s address; thus, if we used the 
address $A$1 (instead of A1) in the addition formula in cell C1 above and then we 
propagated this addition to the next 9 cells, EXCEL would keep the reference $A$1 intact  
while adjusting the reference B1 as before (contents of cell C10 would have been:  
“=$A$1+B10”.) 
 
Select a range of cells:  Select 1st cell in range (upper left corner);  While the cursor lies 
inside the selected cell, press and hold the left mouse button and drag the mouse to the 
lower left corner of the range you want selected.  Release the mouse button. 
 
Inserting Columns or Rows 

Insert a column in front of a given column (say column C): Select the cell that contains the 
label for column C; the selected cell and all cells below it are highlighted. Right-click and 
select “insert” from the pop-up menu.   
 
Experiment with the other options in this pop-up menu. 
 
Insert a row above a given row (say row 5): Select the cell that contains the number 5 for the 
row (left-most cell); that cell and all cells in that row are highlighted. Right-click and select 
“insert” from the pop-up menu. 
 
Formatting cells 

In order to format a cell or a range of cells, we must select them first. Once selected, right-
clicking will open a pop-up window with various options, one of which is “Format cells”. 
Selecting this option will open the window shown below.  It has 5 formatting tabs. The 
“Number” tab instructs EXCEL on how to present the data in the selected cells.   

 

 

 

 

 

 

 

 

 

 

 

 
       Figure 4 

The “Alignment” tab instructs EXCEL how to align the values within a cell (for example right, 
center, left). The “Font” tab is used to specify font related properties such as the type of font, 
size, bold, underline, etc. The “Border” tab is most useful when a range of cells has been 
selected and allows to specify line properties for grid and border lines. Finally, the “Patterns” 
tab allows  to specify cell/range background color and pattern properties. 
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The best way to familiarize yourselves with the various options contained in this window is to 
practice. 
 
Sorting data 

Single Column - data you want to sort are stand alone without any association with data in 
adjacent columns:  Select the range that contains your data, then click on the “Data” menu 
tab and select Sort. Specify Ascending or Descending and click ok. 

Multiple columns – data lie in multiple columns and you want to sort on a particular column 
while maintaining the horizontal association of your data:  Select the entire range, then click 
on the “data” menu tab, and select Sort.  On the Sort window, pick the column you want to 
sort on, specify Ascending or Descending and click ok. 

Undo 

Most toolbars contain a “curved” backward (or left pointing) arrow and a “curved” forward (or 
right pointing) arrow. The former is the UNDO function and the latter is the REDO function. 
By pressing the UNDO button, EXCEL undoes the last action performed. Repeated 
selections of the UNDO function, undo actions performed in reverse chronological order. If 
you perform more UNDOs than desirable, use the REDO function to UNDO the undo action 
of the UNDO button.   

If your toolbars does not contain these symbols, you can find the UNDO / REDO functions in 
the “Edit” menu item. 
 
Charts and Graphs 
You can create a great variety of graphs and charts with the EXCEL “Chart Wizard”. 
 
 
 
 
 
 
 
 
 
 
 
                                         
 
 
 
 
 
 
 
 
                                                 Figure 5 
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In an EXCEL worksheet that looks like the one in Figure 4, click on the “chart wizard”  (to the 
left of the box with the number 100%). The following window opens: 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

                               Figure 6 
 
This is the main window for selecting and specifying the various properties of a graph. For 
each main chart in the scroll-down window labeled “chart type”, there are a number of “Chart 
sub-types” you can select at the right side of the area.  As an example of the main steps 
needed for creating a graph, we will select the “Column” graph, since it is the one we use 
when we want to create a Histogram.  We will use the data values in columns A and B, 
shown in Figure 5. 
 
a) Select the Column chart type, then select the first subtype, then click Next. 
b) Click the Series tab.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

     Figure 7 
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c) Under the Series box, click the Add button; then type “Histogram” in the Name field. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

                                      Figure 8 

d) Clear all values from the box labeled “Values”; click the Collapse Dialog button of the 
Values box, then select the range A1:A10.  Click again on the Collapse Dialog button to 
go back to the Column Chart window. The box should contain: “=Sheet1!$A$1:$A$10”. 

e) Click the Collapse Dialog button of the Category (X) axis labels box, then select the 
values in B1:B10. Click again on the Collapse Dialog button to go back to the Column 
Chart window. The box should contain: “=Sheet1!$B$1:$B$10”. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

   Figure 9 



EXCEL / MEGASTAT Guide  EXCEL Basics 

EXCEL Basics 9 2/27/2007 

f) Click Next 
g) Under the Titles tab, enter: “Classes” in the Category (X) axis box,  and “Frequencies” in 

the Value (Y) axis box. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 10 
 
h) Under the Legend tab, uncheck the Show Legend button. 
i) Under the Data Labels tab, check the Show values button. 
j) Click Next, then Finish 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 11 
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k) Place the cursor on one of the bars, click once to select them, then right click the mouse, 
then select Format Data Series from the dialog box. Click ok. 

l) Click on the Options tab and set the Gap width to zero. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 12 

Functions 

EXCEL contains a fair amount of built-in functions. Each function requires its own set of 
parameters. You do not have to remember the particular set of parameters for each function. 
 
In order to use a function, do the following: 
Place the cursor in the cell where you want to insert a function.  If the symbol  xf  appears in 

your toolbar, click on it; if it does not appear,  click on the Insert menu tab, then select 
Function. In either case, the following window will appear: 
 
  
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 13 

The left scroll down window, contains the various function categories. Once you select a 
category, all the available functions for the selected category appear on the right hand-side 
scroll down window.   The top category keeps track of the last 10 functions used. 

 
As an example, we will use the AVERAGE function. 
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1.We will use the data in A1:A10 from the previous example, Figure 5. 
2. Place the cursor in cell A13, the select the function AVERAGE from the category 

Statistical: 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 14 

3. Click the Collapse Dialog botton of the box “Number 1”, then select the range A1:A10, then 
click ok.  The calculated average 5.5 appears in cell A13. 

Internet Resources 

There are a number of free EXCEL tutorials in the Internet.  You can find them by doing a 
Google search for “EXCEL Tutorial”.  Warning:  some of them are NOT free  
 
 
 
 
 
 
 

 
 
 
 
            Figure 15 
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FREQUENCY DISTRIBUTIONS 
 
EXCEL (Native) PROCEDURE – Quantitative Data 
 
Create Frequency Distribution with 9 classes for the following quantitative data set: 
190, 197, 209, 183, 184, 160, 162, 166, 162, 173, 177, 175, 179, 150, 154, 151, 154, 
159, 157, 144, 148, 136, 132, 129, 117 
 
1. Enter the data in a spreadsheet, cells A3 through A27 
2. #Classes in Cell B29 
3. Calculate Range:  =MAX(A3:A27) – MIN(A3:A27)  �  92 
4. Calculate Range / #Classes:  =B30/B29                  �  10.2222 
5. Calculated Width (Use ROUNDUP function)            �  11   
6. In Columns C1 and D1 enter “LCL” for Low Class Limit, and “UCL” for Upper class limit. 

Figure 16 
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7. Calculate Low Class Limits: 
a. Enter the lowest data value in C3:                      “=MIN(A3:A27)” �     117 
b. Enter the low class limit for the next class:  “=C3+$B$32”            �     128 
c. Propagate this formula for 7 cells to C11 

8. Calculate Upper Class Limits 
a. Enter  in D3:  Low Class Limit + Width –1: “=C3+$B$32-1” �  127 
b. Propagate this to cell D11. 

9. Calculate Boundaries 
a. In cell E3 enter: “=C3 – 0.5” 
b. In cell F3 enter: “=D3 + 0.5” 
c. Propagate the contents of E3 and F3 to E11 / F11. 

10. Calculate MidPoints 
a. In cell G3 enter:  “=(C3+D3)/2”  �  122 
b. Propagate this to G11 

11. Calculate Frequencies 
a. Use FREQUENCY function:  
b. Highlight cells H2:H11 
c. Select Frequency Function 
d. Select the data range A3:A27 
e. In the Bin box, enter the range of the low Boundary values: E3:E11 
f. Press simultaneously the CTRL and SHIFT keys and while holding them down, click 

the OK button. 

12. SUM the frequencies and place result if H12 
13. Calculate Cumulative Frequencies – cf -  in column I. 
14. Calculate Relative Frequencies – rf – in column J:  “=Round(H3/$H$12,2)” 
15. Calculate Cumulative Relative Frequencies – crf - in Column K. 
 
DONE !!!! 
 
EXCEL (Native) PROCEDURE – Qualitative Data 
 
The data below (raw data) represent the blood types of 25 people: 
   A B B AB O 

  O O B AB B 
   B B O A O 

  A O O O AB 
   AB A O B A 
Create a categorical Frequency Distribution. 
 
1. Enter data in cells A2 through A26 
2. Enter the four different categories in Column B, cells B2:B5 
3. Calculate frequencies: In cell C2 enter the formula: “=COUNTIF($A$2:$A$26,B2)”;  This 

EXCEL function instructs EXCEL to look into the range A2:A26 and count the occurrences 
of the value located in cell B2, namely Blood Type A. The result is the number 5. 

4. Propagate this function to cells C3 through C5. 
5. Calculate Cumulative Frequencies – cf – column D. 
6. Calculate Percent Frequencies -  % f  -  column E. 
7. See figure below for end result  
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  Figure 17 
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Bin Frequency

117 1

135.4 2

153.8 5

172.2 8

190.6 7

More 2

Bin Frequency

Bin Frequency Cumulative %

126 1 4.00%

137 3 16.00%

148 2 24.00%

159 6 48.00%

170 4 64.00%

181 4 80.00%

192 3 92.00%

203 1 96.00%

214 1 100.00%

More 0 100.00%

25

EXCEL (Data Analysis) PROCEDURE – Quantitative data 
 
The EXCEL Data Analysis toolpack provides some basic Frequency Distribution creation and 
graphing calculations, the results of which can be augmented using some of the procedures 
outlined above for Native EXCEL manipulations. 
 
You access the above by clicking on the “Tools” menu item and then selecting Data Analysis 
and then Histogram. You should see the figure below. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
                                    Figure 18 
The Input Range box is where you specify the range of the data (A3:A27 in our case). The 
Bin Range is what we would normally call the Upper Class Boundaries. You can leave empty, 
in which case EXCEL will calculate number of classes and class width, or you can calculate 
width and boundaries (see steps 1-5 above for Native Excel) and then specify in the Bin 
Range input field the range that contains the Upper Class Boundaries. 
 
The output for both cases is shown below.  Figure 19 is the result when we did not enter 
anything in the Bin Range field, Figure 20 is the result when we entered Upper Class 
Boundaries in it. 
 
      
 
 
 
 
 
 
 
                  Figure 19 
 
 

                           Figure 20 

In the second case we checked the Cumulative percentage option above. 

The Data Analysis tool will NOT work for Categorical data.
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Frequency Distribution - Quantitative

Data cumulative

  lower  upper midpoint width  frequency percent     frequency percent

116.5 < 127.5 122.0 11.0 1   4.0   1   4.0   

127.5 < 138.5 133.0 11.0 3   12.0   4   16.0   

138.5 < 149.5 144.0 11.0 2   8.0   6   24.0   

149.5 < 160.5 155.0 11.0 7   28.0   13   52.0   

160.5 < 171.5 166.0 11.0 3   12.0   16   64.0   

171.5 < 182.5 177.0 11.0 4   16.0   20   80.0   

182.5 < 193.5 188.0 11.0 3   12.0   23   92.0   

193.5 < 204.5 199.0 11.0 1   4.0   24   96.0   

204.5 < 215.5 210.0 11.0 1   4.0   25   100.0   

25   100.0   

Frequency Distribution - Quantitative

Data cumulative

  lower  upper midpoint width  frequency percent     frequency percent

100 < 120 110 20 1   4.0   1   4.0   

120 < 140 130 20 3   12.0   4   16.0   

140 < 160 150 20 8   32.0   12   48.0   

160 < 180 170 20 8   32.0   20   80.0   

180 < 200 190 20 4   16.0   24   96.0   

200 < 220 210 20 1   4.0   25   100.0   

25   100.0   

MEGASTAT PROCEDURE – Quantitative Data 
 
1. In Megastat you have the option of either specifying yourself the width (in which case you 

need to perform steps 1-5 as above for EXCEL), or let Megastat calculate number of 
classes and width. 

2. Select Megastat �  Frequency Distributions � Quantitative 
3. Set the Input Range to A3:A27 
 
 
 
 
 
 
 
 
 
 
 
                                                Figure 21 

4. Enter 11 for the width and 116.5 for the lower boundary of the first interval, or leave blank 
and have Megastat decide. 

5. Check the boxes for the Histogram, Polygon and Ogive. 
6. Press Ok and see the results in the “OUTPUT” worksheet. 
7. Discuss the output 
8. Figure 22 below shows the distribution that Megastat created if you entered the width. 
9. Figure 23 below shows the distribution that Megastat created when it was asked to 

calculate number of classes and width. In this case, it decided to use 6 classes and width 
of 20. 

10. Observe that Megastat calculates Percent frequencies. However, as we showed in the 
class percent and relative figures are different representations of the same numbers. 

 
 

 
 
 
 
 
 
 
 

         Figure 22           Figure 23 

 
MEGASTAT PROCEDURE – Qualitative Data 

By selecting Megastat �  Frequency Distributions � Qualitative, you can create Categorical 
frequency distributions. The input screen for this option has two input fields: InputRange and 
Specification Range. The InputeRange should contain the raw data: A2:A26 in Figure 17. The 
Specification Range should contain the various categories: B2:B5 in our case of Figure 17. 
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GRAPHS and CHARTS 
                 
In all cases we start the process with Chart Wizard.  Before invoking the Wizard, we should 
have all the required data entered (or calculated) in appropriate EXCEL cells / ranges. 
 
• Histogram (Frequency): 

o Chart Wizard � Column � 1st Sub-Type � 
o Series Tab � Add � Enter : 

1. Name:   Chart Name 
2. Values: Range containing frequencies 
3. Category (X) axis labels: Range containing low class boundaries 
4. � Next 

o Titles tab:  Enter label for “Category (X) axis” (ex: miles traveled, classes, ..) and label 
for “Value (Y) axis” (ex: Frequency). 

o Legend: Uncheck the “Show Legend” box (optional) 
o Data Labels tab: Check the “Show Value” box 
o � Next � Finish 
o Adjust Column Width 

1. Click inside one of the bars 
2. Right-click 
3. Select “Format Data Series” 
4. Click on the “Options” menu item 
5. Set “Gap Width” to zero 
6. �  Ok. 

• Histogram (Relative Frequency or Percent):  
o Same as above, except that: 

1. Name: enter appropriate name 
2. Values: Range containing relative (or percent) frequencies 
3. Titles tab: Appropriate name (i.e Relative Freq or Percent) for “Value (Y) axis” 

• Polygon (Frequency): 
o Chart Wizard � Line � 4th  Sub-Type (already selected) � 
o Series Tab � Add � Enter : 

1. Name:   Chart Name 
2. Values: Range containing frequencies 
3. Category (X) axis labels: Range containing MidPoints. 
4. � Next 

o Titles tab:  Enter label for “Category (X) axis” (ex: miles traveled, Mid Points, ..) and 
label for “Value (Y) axis” (ex: Frequency). 

o Legend: Uncheck the “Show Legend” box (optional) 
o Data Labels tab: Check the “Show Value” box 
o � Next � Finish 
o If you want to connect the graph to the x-axis: 

1. Enter two additional Midpoint Values in the range for midpoints: one above the 
lowest midpoint with a value equal to the lowest midpoint minus the width, and the 
other one at the end of the range with a value equal to the highest midpoint ply 
the width. 

2. Enter two dummy frequency values of zero to correspond to the two new 
midpoints. 

3. Readjust the “Data source” values to reflect the new ranges. 
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• Polygon (Relative Frequency or Percent):  
o Same as above, except that: 

1. Name: enter appropriate name 
2. Values: Range containing relative (or percent) frequencies 
3. Titles tab: Appropriate name (i.e Relative Freq or Percent) for “Value (Y) axis” 

• Ogive (Cumulative Frequency):  
o Chart Wizard � Line � 4th  Sub-Type (already selected) � 
o Series Tab � Add � Enter : 

1. Name:   Chart Name  (“Ogive”) 
2. Values: Range containing cumulative frequencies 
3. Category (X) axis labels: Range containing upper class boundaries. 
4. � Next 

o Titles tab:  Enter label for “Category (X) axis” (ex: miles traveled, Mid Points, ..) and 
label for “Value (Y) axis” (ex: Cumulative Frequency). 

o Legend: Uncheck the “Show Legend” box (optional) 
o Data Labels tab: Check the “Show Value” box 
o � Next � Finish 
o Note on first x-axis point: 

1. Adjust the range of the Upper Class Boundaries by inserting the value for the low 
boundary right above it. 

2. Enter a cumulative frequency of zero in the cumulative frequencies range to 
correspond to the new class boundary value. 

3. Readjust the “Data Source: values to reflect the new ranges. 

• Ogive (Relative Cumulative Frequency or Cumulative Percent):  
o Same as above, except that: 

1. Name: enter appropriate name 
2. Values: Range containing relative (or percent) cumulative frequencies 
3. Titles tab: Appropriate name (i.e Cumulative Relative Freq or Cumulative Percent) 

for “Value (Y) axis” 

• Pareto Chart (Categorical Frequency):  
o Same as Histogram with the addition that the frequency values should be sorted in 

Descending order. Moreover, the range for Boundary values is replaced with the range 
containing the Categories. 

• Pie Chart (Categorical Data):  
o Chart Wizard � Pie � 1st  Sub-Type (already selected) � 
o Series Tab � Add � Enter : 

1. Name:   Chart Name  (“Pie”) 
2. Values: Range containing frequencies 
3. Category (X) axis labels: Range containing categories. 
4. � Next 

o Titles tab:  Nothing to enter 
o Legend: Uncheck the “Show Legend” box (optional) 
o Data Labels tab: Check the “Show Label and Percent” box. 
o � Next � Finish 

 



EXCEL / MEGASTAT Guide  Chapter 2 

Chapter 2 19 2/27/2007 

Frequency Stem  Leaf

3 0   1 2 2
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3 5   1 2 3

3 6   1 2 2

25  

• Time-Series Graph:  
o Time-Series graphs are line graphs used to compare two sets of data when one the 

sets contains “time” related values (i.e. months, years, minutes, …). The “time” values 
become the X-axis labels and the other set are the data values for the graph. 

o Chart Wizard � Line � 1st  Sub-Type (already selected) � 
o Series Tab � Add � Enter : 

1. Name:   Chart Name  ( Some Descriptive name) 
2. Values: Range containing data values or observations 
3. Category (X) axis labels: Range containing “time” values. 
4. � Next 

o Titles tab:  Enter label for “Category (X) axis” (ex: years, months, ..) and label for 
“Value (Y) axis” (ex: Cars Sold, Miles Traveled, …). 

o Legend: Uncheck the “Show Legend” box (optional) 
o � Next � Finish 

• Stem-and Leaf Plots:  
o A Stem-and-leaf plot is a data plot that uses part of the data values as the stem and 

part of the data values as the leaf to form group of classes. It looks like the figure 
below: 

 
 
 
 
 
 
 
 
 
 

Figure 2.1 
o The original data for this plot are:  1  2  2  12 15  19  17  18  19  30  35  36  42 42  48   

48  47 44  45   51 52   53   61 62   62 
o Native EXCEL does not have a function to construct such a plot. 
o Megastat does: Megastat � Descriptive Statistics �  check the “Stem-and-Leaf” box. 

 
• Scatter Plots:  

o A Scatter plot is a plot of order pairs of data values that is used to determine if a 
relationship exists between the two variables. 

o Assume that the two sets of values are in cells A1:A25  and B1:B25. 
o Chart Wizard � XY (Scatter) � 1st  Sub-Type (already selected) � 
o Series Tab � Add � Enter : 

1. Name:   Chart Name  ( Some Descriptive name) 
2. X Values: Range containing x-values:  A1:A25 
3. Y Values :        Range containing y-values:  B1:B25 
4. � Next 

o Titles tab:  Enter label for “Value (X) axis” and label for “Value (Y) axis” . 
o Legend: Uncheck the “Show Legend” box (optional) 
o � Next � Finish 
o Example: 
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Figure 2.2 
 

 


